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1. Introduction

Capsure Enterprise is a suite of 
programs enabling the capture, in-
dex, management and/or export of 
a variety of original documentation.

Capsure Enterprise comprises of 
three main modules:
 Capsure Manager
 Capsure Application

o View
o Scan
o Import
o Scan QA
o Index
o Index QA

 Export

Capsure Manager allows the user 
to create and configure:

- Security (access) 
- Project groups
- Projects
- Index Criteria
- Exports

Ensure that all the software and fig. 1.1 Initial Screen

any purchased licenses are in-
stalled correctly, (See Installation 
Guide).  

During the license installation the 
user will be prompted to set the 
Administrator’s password, ini-
tially set to nothing.  This login and 
password must be used when first 
configuring projects within Capsure 
Manager.

Capsure Manager controls the con-
figuration and set up for projects  
used within the full suite of pro-
grams (see fig. 1.1)

Menu option < File > Log Off will 
allow the user to log off and a new 
user to log on without the necessity 
of closing Manager.

Menu option <Tools> ... gives the 
ability to run any of the Capsure 
software modules without leaving 
the Manager environment and will 
leave Manager running.

Common abbrevialtions used within 
this manual.

RH - right hand

LH - left hand

F&V - Find and View
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2. Initial Setup

Login to Capsure Manager using 
the Administrator password to con-
figure the software suite 

2.1 Tools > Options

Options (Tools >  Options - fig 
2.1.1).  The Options window iwill 
configure the basic setup for the 
Capsure Suite and is divided into 
four tabs.

2.1.1 General 

Not currently implemented (fig 
2.1.1)

2.1.2 Security 

This will apply to all projects.

2.1.2.1 Integrated security

Setting the Integrated security op-
tion (see fig. 2.1.2) will set the user 
automatically to the MS Windows 
login.

NB: Security login should be set on a 
user by user basis if the station is be 
used by more than one user.

2.1.2.2 Password expiry

Unless a user is set with ‘Password 
never expires’ (section 3.2.1.1.1), 
the user will be required to reset 
their password every period set 
here.

fig. 2.1.1 Tools > Options > General

configure the basic setup for the 
Capsure Suite and is divided into 
four tabs.

2.1.1 General 

Not currently implemented (fig 
2.1.1)

fig. 2.1.1 Tools > Options > Generalfig. 2.1.1 Tools > Options > General

This will apply to all projects.

2.1.2.1 Integrated security

Setting the Integrated security op-
tion (see fig. 2.1.2) will set the user 
automatically to the MS Windows 
login.

fig. 2.1.2 Tools > Options > Security
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2.1.2.3 Inactivity Timeout

Each application will log out after a 
set period of inactivity.  That period 
can be set (in seconds) here. 

The default is 900 seconds (15 
minutes).   This time-out will not be 
instigated during scanning, import-
ing or exporting until the taask is 
completed.

2.1.3 Email

This tab (see fig. 2.1.3) is used to 
set up all default email settings 
including warnings and reminders. 

Enter the required details select-
ing  the ‘Use Outlook...’ box if MS 
Outlook is to be the default option 
for email.

A test email can be sent to ensure 
that all the settings are correct.

2.1.4 Deliveries

This setup will act as the default 
style for all projects and is set on 
start up with the delivery name  
(see fig. 2.1.4).  This default (see 
fig 2.1.5) would list deliveries as:

- Delivery 1
- Delivery 2 etc.

It can be set up to include any 
required information i.e. Date.

E.g. Delivery #Number# #Date#
NB This can be reset on a project 
basis using the Deliveries tab within 
Project configureation (see sect 6.2)

ing  the ‘Use Outlook...’ box if MS 
Outlook is to be the default option 
for email.

A test email can be sent to ensure 
that all the settings are correct.

2.1.4 Deliveries
fig. 2.1.4 Tools > Options > Deliveries

style for all projects and is set on 
start up with the delivery name  
(see fig. 2.1.4).  This default (see 
fig 2.1.5) would list deliveries as:

It can be set up to include any 
required information i.e. Date.

E.g. Delivery #Number# #Date#
fig. 2.1.5 Delivery Listing

2.1.2.3 Inactivity Timeout

Each application will log out after a 
set period of inactivity.  That period 
can be set (in seconds) here. 

The default is 900 seconds (15 
minutes).   This time-out will not be 
instigated during scanning, import-
ing or exporting until the taask is 
completed.

2.1.3 Email

This tab (see fig. 2.1.3) is used to 
set up all default email settings 
including warnings and reminders. 

fig. 2.1.3 Tools > Options > Email
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3 Configuration     
settings

This creates the environment within 
which Capsure will run(see fig 3):

3.1 Image Stores

An image store (see fig 3.1) must 
be created before any projects can 
be configured.

The capture process requires a 
specific area to store documents.  
There can be more than one image 
store, i.e. one for each project, or 
all images can be stored in the 
same location. 

Name - is the title of the image 
store (e.g. Project name or New 
Image Store) 

NB: It is good practice to use a 
meaningful or logical name.

Location - can either be local or 
any Shared drive on the network 
previously   created.

Server - Enter the Server name 
(can be found by viewing the 
Properties of My Computer on the 
required machine).  The example 
shown here is server name = Im-
age Server.

Share - Identify the Share by 
entering a previously created share 
name (the example shows the 

Location
any Shared drive on the network 
previously   created.

Server
(can be found by viewing the 
Properties of My Computer on the 
required machine).  The example 
shown here is server name = Im-
age Server.

Share
entering a previously created share 
name (the example shows the 

fig. 3.1 Image Store Settings

An image store (see fig 3.1) must 
be created before any projects can 
be configured.

The capture process requires a 
specific area to store documents.  
There can be more than one image 
store, i.e. one for each project, or 
all images can be stored in the 
same location. 

Namefig. 3 Configuration options
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share name = Capsure_C)

Path - is the share at which the im-
ages will be stored.  In the exam-
ple, the path is set to \ (the share 
level). 

NB – the images can be stored 
below  the share level, in which case 
the path should be set to \share-
name.

The example shows that the im-
ages will be stored on the Server 
called ‘Image Server’ on the 
network share ‘Capsure_C’ with no 
sub directory . (server\share\)

Warning space -  is a user defin-
able point at which a warning mes-
sage will be sent to the Administra-
tor to notify that more storage will 
shortly be required

Min. Free Space - is a user defin-
able point at which a warning mes-
sage will be sent to the Administra-
tor prompting for further storage 
space as no further images can be  
added at the current time. 

3.2 Security

This will allow the setting up of 
Users, Roles and Groups  (see fig 
3.2). There are over many individu-
al security settings that can be set 
against either a user or a role.

These are divided into sections to 
simplify the selection of the correct 
setting . (see fig 3.2.0)

3.2 Security

This will allow the setting up of 
Users, Roles and Groups  (see fig 
3.2). There are over many individu-
al security settings that can be set 
against either a user or a role.

These are divided into sections to 
simplify the selection of the correct 

fig. 3.2 Security Options
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Each section maybe be selected as 
a whole or selected as individual 
options.

3.2.1 Users

Users are the individual operators 
who will be working within Capsure 
/ Find and View.  These users can 
be allowed access to any or all of 
the options within Capsure / Find 
and View using the settings avail-
able within the Permissions tab.

Select Users and  New User from 
the context menu. (see fig 3.2.2).  

3.2.1.1 Details tab

The details required will define how 
the user accesses the software and 
what information is saved against 
the user name 

A user can be either a Capsure 
User (i.e. more than one user can 
work on the same workstation) or 
a Windows User where the user is 
set to the Windows login.

The Username will appear on the 
login screen

The Users real name is used for 
administration purposes

The email address enables the 
user to send email from within the 
software.

a whole or selected as individual 
options.

3.2.1 Users

Users are the individual operators 
who will be working within Capsure 
/ Find and View.  These users can 
be allowed access to any or all of 
the options within Capsure / Find 
and View using the settings avail-
able within the Permissions tab.

fig. 3.2.0 Security Options

fig. 3.2.1 User configuration
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3.2.1.1.1 Password settings 

Once all settings are entered and 
accepted, the current user will be 
prompted to set the password for 
this new user.

Unless ‘Password Never Expires’ 
is set the password will expire 
according to the setup within 
<Tools><Options>Password Expiry  
(see section 2.1.2.2)

Permissions - can be set one by 
one for each individual user or by 
role.  Setting up Roles ensures that 
all operators doing a similar task 
have the same permissions.(see 
section 4 - Security Permissions)

NB: using roles will allow changes to 
be made without the need to address 
every user.

Role - Open the tab and select the 
required Role.  A user may be as-
signed more than one role.

Group - A user may be assigned a 
Group as well as a Role.  This will 
limit the user access to Projects 
as well as tasks and operations.  
Open the tab and select the 
required Group. (See section 4 
- Creating Projects)

3.2.2 Roles 

‘Roles’ allow the administrator to 
configure the same permissions 
for users assigned identical tasks. 
There are a series of predefined 
roles i.e. a scanner operator which 

Group
Group as well as a Role.  This will 
limit the user access to Projects 
as well as tasks and operations.  
Open the tab and select the 
required Group. (See section 4 
- Creating Projects)

3.2.2 Roles 

‘Roles’ allow the administrator to fig. 3.2.2 User Roles selection
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gives access to the right permis-
sions to scan but does not allow 
the user to handle any other task.

To create a Role, select New User 
Role from the context menu.

Use a logical name for the role i.e. 
Supervisor, and select Edit User 
Role from the context menu.  Add 
the required permissions (see fig. 
3.2.2) and click OK.

Any number of Roles can be cre-
ated and edited at any time by the 
administrator or an authorised user.

 3.2.3 Groups

Groups (see fig.3.2.3) are used to 
ensure that only selected users 
are allowed to access and work 
on specific projects. (see section 7 
- Working with Projects)

3.3 Licenses

All Capsure software is controlled 
by license.  Selecting ‘Licenses’ will 
itemise what licenses are available, 
in use and on which workstations. 
(see fig 3.3)

Supervisor, and select Edit User 
Role from the context menu.  Add 
the required permissions (see fig. 
3.2.2) and click OK.

Any number of Roles can be cre-
ated and edited at any time by the 
administrator or an authorised user.

 3.2.3 Groups

fig. 3.2.3 Group selection

3.3 Licenses

All Capsure software is controlled 
by license.  Selecting ‘Licenses’ will 
itemise what licenses are available, 
in use and on which workstations. 

fig. 3.3 Licenses



9

Security Permissions - Section 4
4.1.3 Break Locks

Will regain access to a Batch that 
was illegally closed by a user (i.e. 
the PC crashed whilst the batch 
was open).

4.1.4 Change Any Document 
Owner

Document owners within Find & 
View default to the scanner opera-
tor but may be changed at any time 
with this permission.

4.1.4 Create/Delete/Edit Image 
Stores

Projects may be set to all use the 
same store or individual stores.  
These can be created or edited but 
only deleted if not in use . 

This directly affects where each 
project will store its images. It is 
therefore recommended that only 
the administrator is assigned this 
permission.

4.1.6 Create/Delete/Edit User 
Groups

Rather than assign users to in-
dividual projects, Groups can be 
created and users added to the 
groups.  These groups can then be 
given access to set projects.

4 Security Permissions

Security Permissions enable the 
administrator to set permitted ac-
tivities for each User or Role.  

This can be used to ensure that 
no untrained or unauthorised user 
can access anything for which they 
have not been trained or do not 
have security permission for.

4.1 Administration 

These permissions are generally 
assigned to the Capsure Admin-
istrator i.e. setting up new users, 
roles and groups.  

4.1.1 Administrator

The user is classed as an admin-
istrator allowing the performance 
of any task or action, and access 
to any information within Capsure 
overiding all other restrictions. 

4.1.2 Archiving/UnArchiving

Removes the Deliveries, Con-
signments or Batches from the 
Capsure view and is used when 
the specified group is no longer re-
quired to be accessed (i.e. must be 
kept on the system but has been 
completed and exported). 

The item within Capsure Manager 
is displayed in Grey.  UnArchiving 
reverses this.
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4.1.7 Create/Delete/Edit User 
Roles

Rather than assign permissions to 
individual users, generic roles can 
be created and the users assigned 
the Role.  

Permission may be individually 
added to a user in addition to the 
assigned Role.

4.1.8 Create/Delete/Edit Users

Users should be individuals and 
not generic  to ensure that full se-
curity is maintained and untrained 
users cannot access the wrong 
tasks or projects.

A full audit trail is logged by user.

4.1.9 Delete Any Document

This task is specific to Find and
View and will allow the assigned 
user to over-ride any preset secu-
rity assigned to a document.  

It is recommended that only one 
user (supervisor) has this permis-
sion.

4.1.10 Edit Barcodes

This will allow the assigned user 
to scan and set up how bar-coded 
sheets should be interpreted.  This 
applies to Find and View projects.

4.1.11 Manage Licenses

Managing licenses should only be 
assigned to the Administrator and 
will allow licenses to be added or 
re-assigned.

4.1.12 Modify Security

This gives permission to change 
security and access for any item 
(projects, deliveries etc.) the user 
has access to.
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4.2.5 Edit Images

Allows the user to edit the image 
by rescanning or replacing existing 
images. 

Image clean-up capability is not 
affected by this permission.

4.2.6 Edit Index Data

Allows the user to edit the data 
outside of indexing (i.e. within Man-
ager) and does not affect the user’s 
ability to index.

4.2.7 Mark as Delete

Allows an indexer to re-assess a 
record as ‘to be deleted’ within the 
indexing module. 

If the user is already permitted to 
assess images for scan QA then 
this permission is not  required.

4.2 Basic Permissions

These are permissions common to 
both Capsure and Find and View.

4.2.1 Assess Images

Allows the user to categorise im-
ages as Good (accurate copy of 
the original), Bad (best scan of a 
poor original), Rescan or Delete.

This permission could be used 
during operator training to limit an 
operator to cleaning up the images 
but not do any assessment and 
would allow a trained operator to 
quickly evaluate their work.

4.2.2 Create Record

 Allows the user to create new 
records in a document or batch.  
Required for both Scanning and 
Scan QA

4.2.3 Delete Record

Allows the user to delete records 
from batches and documents.

This is not the same as marking a 
record for deletion within Capsure 
Enterprise (see permission 4.2.7)

4.2.4 Edit Record

Allows the user to edit record 
information such as assessment 
outside of the Scan QA software.
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4.4 Find and View 
Permissions

These permissions are specific to
Find and View and not applicable 
to Capsure.  

Processing within Find and View is 
based around Documents (referred 
to via one set of index criteria).

4.4.1 Create/Delete/Edit 
Documents

This permission restricts the 
creation and/or changes to docu-
ments to qualified/authorised users  
ensuring the integrity of the docu-
ment.

4.4.2 Create/Edit Email 
Profiles

Email profiles are used in Find
& View Retrieve to pre-configure  
information  to be sent when email-
ing, i.e. ‘Send to’ Address, Mes-
sage, Subject etc.

4.4.3 Delete/Edit Live 
Documents

All documents are live unless Find 
& View’s workflow is set to enforce
a review cycle. 

Once documents are Live they can 
be accessed by all authorised us-
ers but only changed by users with 
this permission.

4.3 Capsure Permissions

These are permissions specific to
Capsure and not applicable to Find 
and View.  

Processing within Capsure is 
based around Deliveries, Consign-
ments and Batches.

Batches may be a grouped set of 
documents (i.e. file folder).

Consignments may be  a linked set 
of files (i.e. sales invoices).

Deliveries may be a specific physi-
cal storage area (i.e. filing cabinet
or box).

4.3.1 Create/Delete/Edit 
Batches/Consignments/
Deliveries

Handling of Deliveries, Consign-
ments and Batches can be restrict-
ed by user or role.

4.3.2 Fast Tracking

Deliveries, Consignments and 
Batches are presented to the 
operators of each task in order of 
creation.  

Where necessary, specific tasks
may be marked for immediate 
processing effectively giving the 
item the highest priority.
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4.5 Image Clean-up 
Permissions

These are permissions control 
what aspects of image clean up 
can be handled by an operator

4.5.1 AutoContrast Image

The image is held as grey scale 
until ‘Accepted’ allowing AutoCon-
trast to be used to adjust the qual-
ity of the image without rescanning.

4.5.2 Crop Image

Allows the trimming of ragged or 
irregular borders by drawing a box 
around the section required to be 
retained.

4.5.3 Deskew Image

Allows skewed images to be cor-
rected automatically if the software 
is able to define the borders of the
image or manually by over-drawing 
a line on the image that is should 
be horizontal / vertical.

4.5.4 Despeckle Image

Allows the removal of smaller dots 
or clusters that should not be on 
the image.

4.5.5 Dilate Image

Allows the enhancement of a line 
or text that has become broken 
(dot matrix printing etc.)

4.4.4 Delete/Edit Review 
Documents

If the workflow is set to enforce a
review cycle, changes to  docu-
ments can be restricted the desig-
nated ‘Reviewer’.

4.4.5 Offlining Documents

Allows the user to set a live Find 
& View document as off-line (not 
available for view).

4.4.6 Reproduce Documents

Allows the user to send documents 
via email or save to an external 
(outside Find & View) storage area.

4.4.7 Request Document 
Review

Allows resetting documents to 
Review status.

4.4.8 Review Documents

Enforces a review check before be-
ing released as Live.

4.4.9 Transfer Batches to 
Capsure

Batches exported to Find & View 
from Capsure are no longer avail-
able for editing within Capsure.  
This will allow the reversal of the 
export and allow the batches to be 
edited within Capsure. 
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4.6 Management 
Permissions

These permissions should be 
restricted to the project leader or 
manager as they set the criteria 
used for each project.

4.6.1 Access Configuration

Ensures that configuration  set-
tings (i.e. image storage area and 
licence management) cannot be 
accessed and/or changed by unau-
thorised users

4.6.2 Access Reporting

Gives access to the reporting mod-
ules, both Designer and Viewer

4.6.3 Access Security

Ensures that only authorised users 
can set operator security.

4.6.4 Add/Remove List Items

Allows list fields to be added to or
deleted from during indexing.

4.6.5 Approve Spelling 
Queries

Gives the user the ability to accept 
or reject queried spelling (marked 
during indexing if a field is set for
Spell check - see sect.7.1.2.1.6).  

Accepted words are added to the  
designated custom dictionary.

4.5.6 Flip Image

Allows the mirroring of an image 
around a vertical line.

4.5.7 Mirror Image

Allows the mirroring of  an image 
about an horizontal line.

4.5.8 Negate Image

Permits the user to reverse po-
larity within the image, i.e. black 
becomes white and white becomes 
black.

4.5.9 Rotate Image

Allows the rotation of an image by 
90 or 180 degrees left or right.

4.5.10 Sharpen Image

Allows the user to adjust colour 
images and enhance the definition
between colours.
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4.6.11 Create/Delete/Edit 
Forms

Affects the setting up of forms rec-
ognition fields.

4.6.12 Create/Edit Paper 
Types

Allows the Creation or editing of 
Paper types  used within Report 
Designer (see section     )

4.6.13 Create/Delete/Edit 
Project Groups

Allose Project Groups (see section 
5) to be created,edited or deleted,

4.6.14 Create/Delete/Edit 
Projects

Allows the user to create or edit 
projects (see section 6) but will 
only allow the deletion of ‘empty’ 
projects i.e. projects containing no 
data

4.6.15 Create/Edit Reports

Allows the user to created and edit 
reports (i.e. Progress reports by 
user or task), see section.

4.6.16 Delete Any...

Will allow the user to delete 
batches, fields, projects even if not
designated the project owner.

4.6.6 Create/Delete Custom 
Dictionaries

Allows the user to create/delete 
a custom dictionary specific to a
Project or Project group enabling 
words to be added that are not in 
the general dictionary of choice (i.e 
English(UK)).

4.6.7 Configure Export
Checks

Allows the user to create, edit and 
remove Export checks (i.e. check 
all images have been QA’d)

4.6.8  Create Custom Strings

Allows the user to create custom 
strings, primarily used within the 
export set up.

4.6.9 Create/Delete/Edit 
Exports

Export settings can be adjusted at 
any time by authorised users only 
but will affect all exports from that 
time on.

4.6.10 Create/Delete/Edit 
Fields

Allows the operator to change field
specifications and will affect the
entry and exporting of the specific
project.
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module.

4.7.6 Run Find and View 
Office Config

Controls the ability of the user to 
access  the Office configuratiion
module, an administrative tool for 
setting users, image stores and 
emails settings within Find and 
View Office.

4.7.7 Run Find and View 
Retrieval

Controls the ability of the user to 
access the Find and View Retrieval 
module for the viewing and search-
ing of documents held in Find and 
View.

4.7.8 Run Report Creator

Allows the user to access Report 
Designer to create specific reports
(i.e. progress of work etc)

4.7.9 Run Report Viewer

Allows the user to access the view-
er and therefore print out required 
paperwork, labels or reports.

4.7 Module Access 
Permissions

Allowing access to specific mod-
ules can  be used to ensure that 
operators can only access modules 
on which they have been trained.

4.7.1 Run Capsure Enterprise

Controls whether the user can 
open the Capsure module even 
though  task permission may be 
set.

4.7.2 Run Export

Allows the specified user to send
completed work for export (ready 
for user access or to upload to a 
further application).

4.7.3 Run Capsure Manager

Controls the ability of the user to 
open the Capsure Manager module 
even where  other permission have 
been set..

4.7.4 Run Find and View 
Capture

Controls the ability of the user to 
access the Find and View Capture 
module.

4.7.5 Run Find and View 
Office

Controls the ability of the user to 
access to the Find and View Office
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4.8 Task Permissions

This limits the user to specific tasks
and can be used to ensure that 
only trained and authorised opera-
tors handle each task.

4.8.1 Export Validation

Allows the user to initiate an export 
validation i.e. check that all the 
images and records are ready for 
export.  

This permission alone will not allow 
the user to export data.

4.8.2 Exporting

Allows the user to start the export 
process for Capsure

4.8.3 Find and View Exports

Allows the user to set up exports 
specific to Find and View

4.8.4 Import Images

Allows previously created images 
to be imported.  These can be any 
image format or even MS Word, 
Excel or PowerPoint.

4.8.5 Index QA

Allows the user to do second level 
indexing i.e. enter data again for 
comparison to a previous index 
entry thus enhancing the accuracy 
of data capture.  

4.8.6 Indexing

Allows the user to enter the index 
data required.

4.8.7 Queue/Remove Export 
Jobs

Allows the user to set up and/or 
remove jobs from a queue awaiting 
export

4.8.8 Rescan QA

Allows the user to rescan images 
during QA.  This can be set to off 
even though the user is allowed to 
Scan QA 

4.8.9 Scan QA

Allows the user to assess and edit 
each image previously scanned 
or imported but does not allow the 
user to rescan without setting the 
Rescan QA (4.8.8).

4.8.10 Scanning

Allows the user to capture images 
via a scanner.

4.8.11 Standard Exports

Allows the user to access and initi-
ate standard exports.
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5 Project Groups

A Project Group denotes a source 
of documentation.  

Example A - if capture is being 
handled within a bureau environment 
then a Project Group could be set 
as a company requiring a variety of 
documents captured.

Example B - if the capture is being 
handled within a company then a 
Project Group could be set as a de-
partment requiring several document 
types to be captured.

No permissions or rules can be 
applied to groups and is therefore 
simply used as a means of associ-
ating projects.

5.1 Select Columns

Using the Select Columns will allow  
the display of additional information 
i.e. columns displaying Creation 
and Modified date.

5.2 New Project Group
Permission 4.6.13

Select Capsure on the LH pane 
and open the context menu in the 
RH pane.  (see fig 5.1)

From the context menu select 
<New Project Group> and enter a 
logical name (i.e. the company or 
department name)

No permissions or rules can be 
applied to groups and is therefore 
simply used as a means of associ-
ating projects.

5.1 Select Columns

fig. 5.1 Create Project Group
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5.3 Rename Project Group
Permission 4.6.13

Select a previously created Project 
Group and select ‘Rename Project 
Group’ from the context menu.  
The Project Group can now be 
renamed.

5.4 Remove Project Group
Permission 4.6.13

Selecting a previously created 
Project Group and opening the 
context menu will allow the Project 
Group to be removed, but only if 
the Project Group contains no im-
ages or documents.

These would have to be removed 
prior to removing the group.  A 
warning message is displayed if 
live projects exist within the Group.
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6 Projects 

Projects denote documents with 
identical index criteria.  

E.g. Company XYZ could be re-
quiring two sets of documentation 
for capture

1. Contracts requiring details of 
Name, Address, Contract No. etc. 
2. Sales Invoices requiring de-
tails of Name, Address, Invoice 
Number, Due date, Value etc.

Individual projects would need 
to be created; i.e. Contracts and 
Invoices.

6.1 Options via context 
menu

A variety of options can be selected 
from the context menu (see fig. 
6.1.1).

6.1.1 Select Columns

Using the Select Columns it is pos-
sible to display additional informa-
tion i.e. Creation and Modified date 
(see fig. 6.1.2)

6.1.2  New Project 
Permission 4.6.14

Select the correct Project Group 
and <New Project> from the 
context menu (see fig. 6.1.3).  The 
Project Configuration screen will 
appear. See section 6.2

(see fig. 6.1.2)

6.1.2  New Project 
Permission 4.6.14

Select the correct Project Group 
and <New Project> from the 
context menu (see fig. 6.1.3).  The 
Project Configuration screen will 

fig. 6.1.2 Create Project 

E.g. Company XYZ could be re-
quiring two sets of documentation 
for capture

Individual projects would need 
fig. 6.1.3 Project context menu

6.1 Options via context 
menu

A variety of options can be selected 
from the context menu (see fig. 
6.1.1).

6.1.1 Select Columns

Using the Select Columns it is pos-fig. 6.1.1 Project display columns 
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6.1.3 Edit Project
Permission 4.6.14

Selecting Edit will display the exist-
ing Project configuration and allow 
changes to be made by an author-
ised user. 

6.1.4 Renaming Project
Permission 4.6.14

Will allow a project to be renamed 
by an authorised user.

6.1.5 Archive Project
Permission 4.1.2

Projects can be Archived when 
they are no longer required to be 
accessed but need to be kept ac-
cessible until signed off.

6.2 New Project

Selecting New project from the 
context menu will display the 
Project Configuration window (see 
fig. 6.2.0).

This allows the copnfiguration of all 
the setup unique to the project  

6.2.1 Details Tab

The Details Tab (see fig. 6.2.0) al-
lows the setting of the general data 
for a project.

Projects can be Archived when 
they are no longer required to be 
accessed but need to be kept ac-
cessible until signed off.

6.2 New Project

Selecting New project from the 
context menu will display the 
Project Configuration window (see 
fig. 6.2.0).

This allows the copnfiguration of all 
the setup unique to the project  

6.2.1 Details Tab
fig. 6.2.0 Project confiuration
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6.2.1.1 Project name

Set the project name as something 
relevant or logical, i.e. All contracts 
to be indexed with the same  fields. 
could be handled in a project called 
Contracts.

6.2.1.2 Image Store

Select the image storage area from 
the drop down list box containing 
all previously created image stores.

6.2.1.3 Owner

Individual projects are owned by 
the user logged on at the time of 
creation as default but can be set 
to any user.  Select the required 
user from the drop-down list box.

The Project Owner can edit details 
of that project even if they haven’t 
been assigned the specific permis-
sion required.

6.2.1.4 Title Field

The title field is the indexed field 
data to be displayed in the Record 
Browser screen alongside the 
Document and page numbers.

The title field is selected from the 
list box containing all the index 
fields.  This must therefore left 
blank initially.

Once the index fields have been 
created, ‘Edit’ the project and se-
lect the required field.  If no field is 
selected, this column in the Record 
Browser will remain empty.

relevant or logical, i.e. All contracts 
to be indexed with the same  fields. 
could be handled in a project called 
Contracts.

6.2.1.2 Image Store

Select the image storage area from 
the drop down list box containing 
all previously created image stores.

fig. 6.2.1 Project confiuration - details 
options
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6.2.1.5 Enable Find & View

This option must be selected if the 
Capsure Find & View search and 
retrieval software is to be used.

Once selected  additional ‘Find and 
View’ tabs are displayed (see fig. 
6.2.1.5)

6.2.1.6 Enable Patch codes

Enable Patch Codes on Scan is 
mainly used within Find & View 
to identify the beginning of each 
document.

The software license must also to 
include the ability to read barcodes.

6.2.1.7 Enable Forms 
Recognition

This is currently not implemented 
but is used when documents are 
identical in format and index data 
can be extracted using Optical 
Character Recognition (OCR).

The software license must also to 
include the ability to OCR.

6.2.2 Deliveries Tab

Select the Deliveries tab (see 
figure 6.2.2.1) to configure the 
naming and details required.

6.2.2.1 Naming Style

This will set the format of the De-
livery Name.  The default is config-
ured in the initial setup (see section 
2.1.4)

Character Recognition (OCR).

The software license must also to 
include the ability to OCR.

6.2.2 Deliveries Tab

Select the Deliveries tab (see 
figure 6.2.2.1) to configure the 
naming and details required.

fig. 6.2.2.1 Project confiuration - 
Deliveries tab

fig. 6.2.1.5 Project confiuration - 
including Find & View tabs
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This can be Delivery followed by a 
number (sequentially rising by one 
for each new delivery within the 
Project)

The variable information is con-
tained within # whilst the fixed 
information is entered as required.

In the example shown in fig. 6.3.1. 
the deliveries will be named

Delivery 1 (Financial Contracts)

where 1 is the next sequential 
number and Financial Contracts is 
the data entered into the Source 
box.  The first delivery number is 
set within the Numbering tab (see 
section 6.2.3)

The delivery name can contain any 
of the following variables:

- #Number#
- #Date#
- #DateTime#
- #Time#
- #Source#

Date, Time and Source are taken 
from the  data collected at the time 
of creation of the delivery.

6.2.2.2 Data to collect

Additional data specific to each de-
livery can be collected when a de-
livery is created. (see fig. 6.2.2.2).

number and Financial Contracts is 
the data entered into the Source 
box.  The first delivery number is 
set within the Numbering tab (see 
section 6.2.3)

The delivery name can contain any 
of the following variables:

fig. 6.2.2.2 Project confiuration - 
Deliveries - addition data
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In the example shown in fig. 
6.2.2.1, the Source data will be col-
lected at the delivery creation time 
and used as part of the delivery 
name.

This data can be displayed in the 
delivery listings within Manager by 
selecting the appropriate columns 
for display, see section 8.1.1.

6.2.3 Numbering Tab

This tab (see fig 6.2.3.1) allows 
the user to specify the first number 
to be used for both delivery and 
consignment and the structure of 
the UPI (Unique Page Identifier) if it 
is to be used.

6.2.3.1 Start number

The starting number for both Deliv-
ery and Consignment can be set by 
using the up/down arrow or enter-
ing the required number.

6.2.3.2 Use Unique Page 
Indentifiers (UPI)

This option allows for every docu-
ment page/image to have been  
uniquely identified with a number 
prior to scanning (i.e by stamping 
or bar-coding).  

The scanned image is then specifi-
cally linked to its original via this 
number and allows for the accurate 
location and identification of an 
original.

This tab (see fig 6.2.3.1) allows 
the user to specify the first number 
to be used for both delivery and 
consignment and the structure of 
the UPI (Unique Page Identifier) if it 
is to be used.

6.2.3.1 Start number

fig. 6.2.3.1 Project confiuration - 
Numbering tab
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The UPI can be up to 20 charac-
ters in length and made up of the 
consignment number (C), Batch 
number (B), Insert number (I) and 
Sequence number (S). 

The insert number is used when 
originals are scanned and a page is 
missed.  The insert number 1 signi-
fies the first insert after the sequence 
number following (i.e. 1527 is imme-
diately after 0527)

The structure of the UPI can be set 
using the mask as shown in the ex-
ample in fig. 6.2.3.1.  The example 
is made up of:

- 4 digit consignment number
- 2 digit batch number
- 1 digit to allow for inserts
- 3 digit sequence number

In the example shown in fig. 6.2.3.2 
the

Consignment = 101
            Batch = 5
     Sequence = 527

6.2.4 Image Security tab

Image security (see fig 6.2.4.1) is 
not currently implemented but will 
allow for:

- checksum images
- encrypt images
- strong encryption

Checksum images ensures that, 
if an images is altered outside of 
the software, it will no longer be 
classed a valid image.

fig. 6.2.4.1 Project confiuration - 
Image Security tab

fig. 6.2.3.2 Project confiuration - UPI 
structure
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Encrypt images will code the imag-
es such that an alternate software 
cannot be used to read the images.  
This can be important if image data 
is of a sensitive nature.

Strong encryption will give the 
greatest security of image data.

6.2.5 E-mail tab

The software can be set to send 
administrative emails notifying a 
designated operator/administrator 
that there is something requiring 
attention (see fig 6.2.5.1).

Enter the designated email address 
and select the events required to 
be notified.

The Admin Email Signature can 
be left as the default or adjusted to 
suit the specific environment.

6.2.6 Find & View tabs

These  will only be displayed if 
‘Enable Find & View’ has been 
selected on the Details tab.

The available settings control the 
workflow used within Find & View 
Capture and Retrieve (see fig. 
6.2.6.0.1 & 6.2.6.0.2)

6.2.6.1 Allow document 
reproduction

Allows documents within this 
project to be viewed outside Find & 
View via print or email.

fig. 6.2.6.0.1 Project confiuration 
- Find & View tab

fig. 6.2.5.1 Project confiuration 
- Email tab

‘Enable Find & View’ has been 
selected on the Details tab.

The available settings control the 
workflow used within Find & View 
Capture and Retrieve (see fig. 
6.2.6.0.1 & 6.2.6.0.2)

6.2.6.1 Allow document 
reproduction

Allows documents within this 
project to be viewed outside Find & 
View via print or email.fig. 6.2.6.0.2 Project confiuration 

- Find & View (more) tab



28

Projects - Section 6
6.2.6.2 Watermark documents

Adds a watermark to the repor-
duced document (where document 
reproduction is allowed).  This 
watermark can be configured using 
the watermark options window (see 
fig 6.2.6.2).

A sample of the selection is dis-
played to enable the user to ap-
prove the format of the watermark.

6.2.6.3 Email image format

Images can be emailed as multi-
page TIFF or PDF by selecting 
from the list of options.

6.2.6.4 Documents awaiting 
review can be searched

Selecting this option (see fig. 
6.2.6.4 will allow an authorised 
user to locate any document within 
Find & View regardless of whether 
it has been released as ‘Live’.

Workflow options are available by 
clicking the ‘Edit Workflow’ button 
(see fig. 6.2.6.4.1).

6.2.6.4.1 Workflow option - Pre-
Review

Not currently implemented

Adds a watermark to the repor-
duced document (where document 
reproduction is allowed).  This 
watermark can be configured using 
the watermark options window (see 
fig 6.2.6.2).

A sample of the selection is dis-
played to enable the user to ap-
prove the format of the watermark.

6.2.6.3 Email image format

Images can be emailed as multi-
page TIFF or PDF by selecting 

fig. 6.2.6.2 Project confiuration - 
Watermark options

Selecting this option (see fig. 
6.2.6.4 will allow an authorised 
user to locate any document within 
Find & View regardless of whether 
it has been released as ‘Live’.

Workflow options are available by 
clicking the ‘Edit Workflow’ button 
(see fig. 6.2.6.4.1).

fig. 6.2.6.4 Project confiuration - Find 
& View workflow

Not currently implemented

fig. 6.2.6.4.1 Project confiuration 
- Find & View workflow options
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6.2.6.4.2 Workflow option - 
Review

To set the Review workflow the fol-
lowing items chan be selected, see 
fig. 6.2.6.4.2.

Review Mode allows the choice of
• Hierarchical (passed to the next 
reviewer only if accepted)
• Consensus (passed to all 
reviewers with majority voting to 
accept)
• Unanimous (passed to all 
reviewers and only accepted if all 
agree)

Notification Method can be set to 
flag the reviewer by:

• Systems Tray Notification (plac-
ing an icon in the systems tray 
only)
• Passive Notification (a post-it 
style note appears above the 
systems tray & enforcing no ac-
tion)
• Passive & Systems Tray notifi-
cation will use both methods

Reviewer Selection sets who are 
included in the workflow:

• Fixed Reviewers (set by select-
ing up to five users)
• Indexed Reviewers (reviewers 
taken from indexed data) see 
fig.6.2.6.4.2.1.
• Selected by List field (list items 
selected at indexing determine 
the reviewer.  Any number of 
items can be set.  Unselected 
list items go to the default) see 
fig.6.2.6.4.2.2

To set the Review workflow the fol-
lowing items chan be selected, see 
fig. 6.2.6.4.2.

Review Mode allows the choice of

fig. 6.2.6.4.2 Project confiuration - 
Find & View workflow Review options

fig. 6.2.6.4.2.1 Project confiuration - 
Find & View workflow Review options

Reviewer Selection sets who are 
included in the workflow:

fig. 6.2.6.4.2.2 Project confiuration - 
Find & View workflow Review options
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6.2.6.4.3 Workflow option - Post-
Review

Not currently implemented

6.2.6.6 Document naming

Wherever documents are listed 
(i.e. in search results, awaiting 
review lists etc.) they are listed by 
document name which can be left 
as default (New Document (date 
time) see fig.6.2.6.6a) or set using 
the contents of an index field (see 
fig. 6.2.6.6.b).  

If this option is selected all the 
available fields will be listed for 
selection.  

If fields have not yet been created 
then a message will be displayed 
stating this. See section ‘Working 
with a Project’

6.2.6.7 Searchable fields

This option is the selection of ad-
ditional fields to be used in search-
ing, i.e. Document Status and 
Document Date.  These fields are  
populated automatically.

6.2.6.8 Scanning

This options will set up default auto 
crop and deskew on scanning.  
This can be overridden within the 
Scan module of Capsure Enter-

fig. 6.2.6.6 Project confiuration - 
Document Naming options

time) see fig.6.2.6.6a)
the contents of an index field (see 
fig. 6.2.6.6.b).  

If this option is selected all the 
available fields will be listed for 
selection.  

Wherever documents are listed 
(i.e. in search results, awaiting 
review lists etc.) they are listed by 
document name which can be left 
as default (New Document (
time) see fig.6.2.6.6a)
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prise.

6.2.7 Project Security

Security can be set against the 
project as well as against the im-
ages and the tasks.

If ‘Inherit from the parent’ is not se-
lected then either groups or users 
can be Allowed/Disallowed access 
to the project. (see fig. 6.2.7.1)

When setting this read the selected 
options carefully to ensure that 
users that are expected to access 
the project are Allowed rather than 
barred. 

6.2.8 Exports Tab

Workflow for exports can be set 
specifically to the project.

6.2.8.1 Archive Items on 
Export

The export setting default can be to 
archive the exported items auto-
matically on completion of a suc-
cessful export.  Where more than 
one export type is to be run within 
a project, this should be set off.

6.2.8.2 Allow Export Queuing

Export can either be completed 
‘Now’ or ‘Queued’.  Queuing is 
used where specific Plug ins are 
required which are installed on 
set PCs as in Optical Character 
Recognition.

6.2.8 Exports Tab

Workflow for exports can be set 
specifically to the project.

6.2.8.1 Archive Items on 
Export

fig. 6.2.7.1 Project confiuration 
- Exports

fig. 6.2.7.1 Project confiuration - 
Project Security
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All exports are listed in the Export 
Queue visible from Manager.

7 Working with a 
Project

Project setup is made up of five 
options

- Project Configuration
- Field Setup
- Dictionary & Spelling
- Deliveries
- Exporting

Before creating a delivery the index 
criteria must be set. (see fig 7.0.1)

Expand the required project until 
the option ‘Fields’ is visible (see fig 
7.0.2).

7.1 Field Setup
Permission 4.6.8

Highlight ‘Fields’, and select ‘New 
Field’ from the context menu to 
display the Field Configuration 
window. (see fig 7.1.0).

Configure each field as close to 
the client data specifications as 
possible, data entry will be more 
accurate and errors minimised.

Study the documents and the 
supplied specification thoroughly 
before setting up a test.

Any part of the field configuration 
can be changed but it is important 
to test and adjust the setup until 

window. (see fig 7.1.0).

the client data specifications as 

fig. 7.1.0 Field configuration

All exports are listed in the Export 
Queue visible from Manager.

7 Working with a 
Project

Project setup is made up of five 
options

fig. 7.0.1 Project set up

Before creating a delivery the index 
criteria must be set. (see fig 7.0.1)

Expand the required project until 
the option ‘Fields’ is visible (see fig 
7.0.2).

7.1 Field Setup
fig. 7.0.2 Field set up
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the data entered accurately repre-
sents the documents and conforms 
exactly to the specification.

7.1.1 Field Tab

This tab sets the main criteria for 
the field.

7.1.1.1 Name

Enter a descriptive name for the 
field e.g. Contract Name if the 
client name on the contract is 
required.  

7.1.1.2 Description

Adding a description can prompt 
the indexer on location of the data 
or rules to follow etc.  This will ap-
pear as a floating prompt.

7.1.1.3 Type 

Select the type of field required. 
(fig. 7.1.1.3)

7.1.1.3.1 Text 

Text fields are generally used 
where the data is unstructured i.e. 
for name and/or description and 
may have Spell Checking set (see 
section 7.1.5)

7.1.1.3.2 List 

List fields will present a drop down 
list box within the Index entry 
screen containing pre-entered 
choices .

the data entered accurately repre-
sents the documents and conforms 
exactly to the specification.

7.1.1 Field Tab

This tab sets the main criteria for 
the field

7.1.1.1 Name

Enter a descriptive name for the 
field e.g. Contract Name if the 
client name on the contract is 
required.  

7.1.1.2 Description

fig. 7.1.1 Field Tab

7.1.1.3 Type 

Select the type of field required. 
(fig. 7.1.1.3)

Text fields are generally used fig. 7.1.1.3 Field Type
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7.1.1.3.3 Number

Number fields are used wherever a 
positive or negative quantity is be 
entered .

7.1.1.3.4 Currency 

Currency fields will limit the entry to 
two or three digits after a decimal 
point.   

7.1.1.3.5 Date

Date will only allow a valid entry 
to be made and is in the format 
dd/mm/yyyy.

7.1.1.4 Default

If a field cannot be blank then  a 
default value can be set which will 
be applied as the indexer leaves 
the record.

7.1.1.5 Level

The data entry can apply to a 
group of documents or be unique 
to one. To apply the entry to a 
group, pull down the Level list box 
and select (see fig 7.1.1.5):

NB: Find & View projects cannot be 
assigned with Consignment or Batch 
fields.

In other projects, if Consignment or 
Batch is selected, ensure that the 
original  documentation is split such 
that the selected group (Consign-

the record.

7.1.1.5 Level

The data entry can apply to a 
group of documents or be unique 
to one. To apply the entry to a 

fig. 7.1.1.5 Field Level
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ment or Batch) will only require one 
data entry for this field.

7.1.1.6 Validation rules

Select the required setting (see fig 
7.1.1.6):

> ReadOnly - used if data is 
collected via header sheets and 
must not be altered.
> Mandatory - a required entry
> Double Index - ensures accu-
racy for critical fields and adds an 
additional step, Index QA, to the 
work flow.

7.1.2 Option Tab

The Options tab is not present 
for the Date field type.  This tab 
reflects the additianal options 
available based on the field type 
selected

7.1.2.1 Text Option 

Where the field type is text the fur-
ther options (see fig 7.1.2.1) are :

7.1.2.1.1 Length

The default is 50 characters.  This 
should be set to a specific length if 
the data to be entered is a known 
length or has a fixed maximum to 
aid index accuracy 

7.1.2.1.2 Virtual Length

If the original data to be entered in 
a field can be any length but the 
data to be exported cannot exceed 
a specific length,  use the Virtual 

7.1.2 Option Tab

The Options tab is not present 
for the Date field type.  This tab 
reflects the additianal options 
available based on the field type 
selected

7.1.2.1 Text Option 
fig. 7.1.2.1 Option Tab - Text

fig. 7.1.1.6 Field validation
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Field length to enter all the original 
data.  

This data can then be abbreviated 
according to the given specifica-
tions for the project.  The field 
background will change colour 
when the expected maximum is 
exceeded and will only revert when 
the data is abbreviated to the set 
maximum.

E.g: the title of a document is quite 
verbose but would not make sense 
with arbitrary abbreviations (comm. 
for committee etc.). The full data 
can be entered:-

“The Formation of the joint investi-
gative committee for the Evaluation 
of the Interview process” - 94 chars

The maximum length is set to 40 
characters (this may be dictated 
by the document management 
system).  

It is visually easier for the indexer 
to remove the unnecessary words 
on the screen leaving the text to 
read: 

data.  

This data can then be abbreviated 
according to the given specifica-
tions for the project.  The field 
background will change colour 
when the expected maximum is 
exceeded and will only revert when 

fig. 7.1.2.1.2 Field length & virtual 
length
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fig. 7.1.2.1.3.1 Allowed/Disallowed

Character restrictions Allow/
Disallow Setting

A-Z plus space Allow ‘A’ and space in box
Any alpha plus special characters

Allow
‘A’ ‘a’ and enter 
required special 
characters in box

Any character except those illegal 
in a filename Disallow

Only numerics Allow 0

Table 7.1.2.1.3.2 Illegal filename 
characters

See examples 1-4 shown in table 
7.1.2.1.3.2

7.1.2.1.4 Filter

Filters can be set to ensure the cor-
rect use of capital letters. 

Upper Case - converts alpha char-
acters to upper case (e.g. ‘aBcdeF’ 
would be saved as ‘ABCDEF’)

Lower Case - converts alphabetic 
characters to lower case.  The ex-
ample would be saved as ‘abcdef’.

Sentence Case - converts the 1st 
character of each word to upper 
case. e.g:

‘A quick brown fox’ would be saved 
as ‘A Quick Brown Fox’ which can 

“Formation committee re interview 
process” - 40 chars

7.1.2.1.3 Allowed / Disallowed 
characters 

These two options (see fig. 
7.1.2.1.3.1) are mutually exclusive 
as setting Allowed characters will 
not permit a Disallowed selection.  
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Symbol Description Usage and Example

^ Caret Denotes the beginning of the expression

$ Dollar Denotes the end of the expression

[ ] Square Brackets Placed either side of a range or 
group of characters i.e. [a-zA-Z]{1} 
means that this one character can 
be in the range a-z and A-Z

{n} Braces with total 
number of characters 
to be matched

Placed either side of the quantity (n) 
that the mask refers to. i.e. [a-zA-Z]{3} 
means that three characters can only 
be in the range a-z or A-Z or [aeiou]{2} 
means that the first two characters can 
only be contained in the group ‘aeiou’

{n,m} Braces with maximum 
& minimum number 
of characters

As above but where n=minimum 
number of characters and m=maximum 
number of characters. i.e. [A-Z]{0,2} 
means that a character in the range A-Z 
may appear in either 0,1,2 characters

. Full Stop
Denotes any character. i.e. [.]{5} 
means that any character may be in 
the next five character positions

Table 7.1.2.1.5 Characters used to 
create a mask be useful when entering Names, 

Addresses or Company names.

7.1.2.1.5 Mask 

A Mask is used to specifically
format data i.e. 2 alpha character 
followed by 4 numerics and 1 alpha 
(e.g. AB4321X). 

The mask would be created us-
ing charachters detailed in Table 
7.1.2.1.5 and set as:

^[A-Z]{2}[0-9]{4}[A-Z]{1}$

This mask would ensure that the 
data entered matched the configu-
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ration 2 alpha character followed 
by 4 numerics and 1 final alpha. 

7.1.2.2 Number Option 

Selecting the field type as number 
allows further options (see fig 
7.1.2.2) :

- Allow negative numbers
- Decimal Places
- Minimum
- Maximum

The defaults for the minimum and 
maximum are initially shown and 
can be adjusted by entering the re-
quired min/max or by setting using 
the up/down arrows.

7.1.2.3 Currency Option

Selecting the field type as currency, 
(see fig 7.1.2.3) allows further op-
tions 

7.1.2.3.1 Allow Multiple 
Currencies

Each currency required must be 
selected from the displayed list. 
Any or all of the currencies may be 
selected.

On completion, select the default 
currency from the drop down list 
box.

The index display will show a 
combined field, a list of all selected 

ration 2 alpha character followed 
by 4 numerics and 1 final alpha. 

7.1.2.2 Number Option 

Selecting the field type as number 
allows further options (see fig 
7.1.2.2) :

The defaults for the minimum and 
maximum are initially shown and fig. 7.1.2.2 Options - number

the up/down arrows.

7.1.2.3 Currency Option

Selecting the field type as currency, 
(see fig 7.1.2.3) allows further op-
tions 

Each currency required must be 
selected from the displayed list. 
Any or all of the currencies may be 
selected.

On completion, select the default 
currency from the drop down list fig. 7.1.2.3 Options - currency

The index display will show a 
combined field, a list of all selected 

fig. 7.1.2.3.1 Index display of 
multiple currency
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currencies and an entry field for the 
value (see fig.7.1.2.3.1).

7.1.2.4 List Option

Selecting the field type List allows 
further options to be selected.

7.1.2.4.1 Parent Fields and 
Values

A list field can be either stand alone 
or be dependent upon a parent 
(see fig. 7.1.2.4.1).  

A dependent list requires a pre-
viously created and populated 
Parent Field.  The items are then 
added against specific items selec-
tion from the parent field. 

E.g. Parent field = department, 

dependent list = employees within 
the specified department.

7.1.2.4.2 List Values

List values can be added one by 
one using Add, or Imported from a 
previously created source that has 
been saved as a delimited text file.  

Importing list values can be used 
where the data is complex or long 
e.g. client names, email addresses, 
supplier names etc.

Values can be removed one by 
one, by ticking the required items 

currencies and an entry field for the 
value (see fig.7.1.2.3.1).

7.1.2.4 List Option

Selecting the field type List allows 
further options to be selected.

A list field can be either stand alone 
or be dependent upon a parent 
(see fig. 7.1.2.4.1).  

A dependent list requires a pre-
viously created and populated 
Parent Field.  The items are then fig. 7.1.2.4.1 Options - list
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and selecting Remove, or the en-
tire list emptied via Clear.

7.1.2.4.3 Can add/Remove list 
values

Permission 4.6.4

List values can be added or re-
moved during the index process 
provided the indexer has been 
given security permissions to do 
so.

Useful where the list items are con-
stantly changing i.e. new customers 
added, old suppliers removed etc..

7.1.3 Quick Keys Tab

The Quick Keys tab is only avail-
able for text fields. (see fig. 7.1.3).

When phrases, names or words 
are repeated within text fields, 
typing errors can be minimised by 
assigning up to nine of the most 
common to function keys F1 - F10.

These function keys can be set dif-
ferently for each text field.

Once assigned, the indexer can 
insert the phrase or word by select-
ing the correct function key during 
data entry in the appropriate field.

E.g. The index data should be  ‘A 
decision was reached by the Depart-
ment of Works & Pensions......’  

The indexer would only need to type 
‘A decision was reached by the’ and 
then use the F4 key where ‘Depart-

7.1.3 Quick Keys Tab

The Quick Keys tab is only avail-
able for text fields. (see fig. 7.1.3).

When phrases, names or words 
are repeated within text fields, 
typing errors can be minimised by 
assigning up to nine of the most 
common to function keys F1 - F10.

These function keys can be set dif-
ferently for each text field.

Once assigned, the indexer can 
insert the phrase or word by select-

fig. 7.1.3 Quick Key Tab
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ment of Works & Pensions’ has been 
assigned to F4.

7.1.4 Find & View Tab

Find & View tab (see fig. 7.1.4) is 
common to all the field types and 
defines whether the field will be:

- Searchable
- Displayed in search results
- Displayed in all Document lists

Find & View Retrieve can be 
used to located and display any 
document indexed and exported 
into F&V using any known data 
wherever that data field has 
been defined as searchable.

7.1.5 Spelling

The Spelling tab is only available 
for text fields. (see fig. 7.1.5).  

Any text field can be set to be 
automatically spell checked by 
selecting the ‘Spell Checked’ option 
within the Spelling tab.

Select the language required for 
the dictionary from the drop down 
list box.

NB: There is both an English UK and 
US available

Select the previously created 
custom dictionary if words are to 
be added to the standard diction-
ary. See section 7.4 Dictionaries & 
Spelling for details.

NB: If all the words should be found 

7.1.4 Find & View Tab

Find & View tab (see fig. 7.1.4) is 
common to all the field types and 
defines whether the field will be:

Find & View Retrieve can be 
used to located and display any 
document indexed and exported 
into F&V using 

fig. 7.1.4 Find & View Tab

fig. 7.1.5 Spelling tab

been defined as searchable.

7.1.5 Spelling

The Spelling tab is only available 
for text fields. (see fig. 7.1.5).  

Any text field can be set to be 
automatically spell checked by 
selecting the ‘Spell Checked’ option 
within the Spelling tab.

Select the language required for 
the dictionary from the drop down 
list box.
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in the selected standard dictionary 
then this is unnecessary. 

From the list of options, select the 
most appropriate for the new field.  
This will ensure that unnecessary 
words do not have to be added to 
the dictionary (e.g. 17th, ISO2345 
etc).

It will also minimise the number 
of times the indexer will have to 
‘Ignore’ words and the Supervisor 
have to examine words added to 
the custom dictionaries before a 
batch can be exported.

It is important to understand the 
data to be entered into the specific 
field to minimise interaction from 
the operators.

7.2 Field Layout

When all the fields have been cre-
ated they must be layed out in the 
sequence required for indexing. 
(see fig. 7.2.1).  

NB If fields have been created but no 
Layout has been created, no fields 
will be visible within the index data 
pane.

This layout should match the order, 
as closely as possible, in which 
they will be found on the docu-
ments to be indexed.

It is not important to consider the 
required export order, only the se-

When all the fields have been cre-
ated they must be layed out in the 
sequence required for indexing. 
(see fig. 7.2.1).  

This layout should match the order, 
as closely as possible, in which 
they will be found on the docu-
ments to be indexed.

fig. 7.2.1 Field Layout selection
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quence in which the data is displayed 
on the original and therefore indexed.

Indexers will enter data more effi-
ciently if they are reading the docu-
ment from top to bottom for index 
information rather than extracting it 
from random locations.

The fields are listed in the top left 
frame within the Layout window 
(see fig. 7.2.2). The field name 
is removed from the list as it is 
dragged and dropped onto the right 
hand frame.

The different colouring of the field 
entry box signify whether the data 
is entered once per Consignment, 
Batch or Document.  .

Each field should be dragged and 
dropped onto the grid in the se-
quence the data is to be collected.  

The field can be resized using the 
handles.  Only text fields can be 
adjusted vertically to allow long 
textural input to be displayed.  

All other fields can only be adjusted 
by width and should be lengthened 
sufficiently to enable all the field 
data to be displayed.

The grid represents 100% width of 
the index frame within the Index 
panel.  Fields can be laid out next 
to each other or below each other 
(see fig. 7.2.3)

Figure 7.2.4 shows how the layout 

Indexers will enter data more effi-
ciently if they are reading the docu-
ment from top to bottom for index 
information rather than extracting it 
from random locations.

The fields are listed in the top left 
frame within the Layout window 
(see fig. 7.2.2). The field name 
is removed from the list as it is 
dragged and dropped onto the right 
hand frame.

fig. 7.2.2 Field Layout

The field can be resized using the 
handles.  Only text fields can be 
adjusted vertically to allow long 
textural input to be displayed.  

All other fields can only be adjusted 
by width and should be lengthened 
sufficiently to enable all the field 
data to be displayed.

The grid represents 100% width of 
the index frame within the Index 
panel.  Fields can be laid out next 

fig. 7.2.3 Field Layout
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shown in fig. 7.2.3. looks within the 
Index frame.

If there is sufficient room , place the 
fields one under another to give the 
indexer maximum display for each 
field.

The sequence of the fields can be 
altered at any time (provided the 
user has the correct permission) 
until the layout is satisfactory.

To delete fields from the layout, 
select the required field and click 
Delete.  The field name will appear 
back in the  top left hand frame.

NB. Warning - If the indexer com-
ments that the entry sequence is 
incorrect, check the layout carefully.  
The entry sequence is determined by 
the order the fields are placed on the 
layout screen.  Fields layed out side 
by side must be at the same level, if 
the higher of the two is to the right it 
will be before the left had field.

7.3 Bar Code & OCR setup 

Barcodes and Patch codes (short 
barcodes specifically designed to 
be interpretted by scanners) can be 
preprinted onto sheets and used to 
pass instructions to the scanner or 
data to the index fields.

Select the barcode setup (see fig. 
7.3.0.1) to bring up the barcode 
configuration screen. (see fig. 
7.3.0.2)

Scan the pre-printed sheet and 
select Auto-Detect.  The software 

shown in fig. 7.2.3. looks within the 
Index frame.

The sequence of the fields can be 
altered at any time (provided the 
user has the correct permission) 
until the layout is satisfactory.

To delete fields from the layout, 
select the required field and click 
Delete.  The field name will appear 
back in the  top left hand frame.

fig. 7.2.4 Field Layout within Index 
module

7.3 Bar Code & OCR setup 

Barcodes and Patch codes (short 
barcodes specifically designed to 
be interpretted by scanners) can be 
preprinted onto sheets and used to 
pass instructions to the scanner or 
data to the index fields.

Select the barcode setup (see fig. 
7.3.0.1) to bring up the barcode 
configuration screen. (see fig. 
7.3.0.2)

fig. 7.3.0.1 Barcode Setup
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will examine the sample page and 
outline any and all barcodes found.  
The sample used in fig. 7.3.3 is 
Patch Code 1 plus two ID numbers

Draw a box around any bar codes  
not detected,   If unrequired bar-
codes are detected, select and 
delete.  This will remove the outline 
box placed around the extrateous 
barcode.

7.3.1 Configure Patch Codes

Select the required action from the 
drop down list box (see fig. 7.3.1).  

7.3.1.1 Mark next page as 
deleted

Would not save the barcode sheet 
image or the image immediately 
following.

7.1.3.2 Mark page as deleted

Would not save the barcoded 
sheet.  This sheet could be used to 
contain information required for the 
reconstruction of the documents 
and therefore not required as an 
image.

7.3.1.3 New Document

Would discard the Barcode sheet 
image and flag the next image as 
New Document.

7.3.1.4 New Document & 
check for Barcodes (OCR)

Would discard the barcode sheet, 

fig. 7.3.0.2 Barcode Configuration

will examine the sample page and 
outline any and all barcodes found.  
The sample used in fig. 7.3.3 is 
Patch Code 1 plus two ID numbers

Draw a box around any bar codes  
not detected,   If unrequired bar-
codes are detected, select and 
delete.  This will remove the outline 
box placed around the extrateous 
barcode.

7.3.1 Configure Patch Codes

Select the required action from the fig. fig. 7.7.3.0.3.0.22 Barcode Barcode ConConfigufigurationration

7.3.1.1 Mark next page as 
deleted

Would not save the barcode sheet 
image or the image immediately 
following.

7.1.3.2 Mark page as deleted

Would not save the barcoded 
sheet.  This sheet could be used to 
contain information required for the 
reconstruction of the documents 

fig. 7.3.1 Patch code Configuration
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sheet and switch the scanner setup 
to start scanning Greyscale images 
at 150dpi

7.3.1.11 Scan Greyscale 
200dpi

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Greyscale images 
at 200dpi.

7.3.1.12 Scan Single sided

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Single sided im-
ages.

7.3.2 Barcode Settings

To designate the index fields,
highlight the required barcode and 
select the destination index field
from the ‘Field’ list box as shown in 
fig. 7.3.2.

Repeat this for all index barcodes 
on the scanned sample sheet and 
then use the <Test Barcode Area> 
to confirm that all the barcodes
have been correctly recognised 
and acted upon.

Once the setup is completed the 
required action will take place 
every time a barcode sheet is 
encountered where the Project has 
been set with ‘Enable Barcode & 

flag a new document  and place
the information contained in the 
barcode(s) into the configured
index field(s). (See section 7.3.2)

7.3.1.5 Scan B&W 200dpi

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Black & White im-
ages at 200dpi.

7.3.1.6 Scan B&W 300dpi

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Black & White im-
ages at 300dpi.

7.3.1.7 Scan Colour 150dpi

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Colour images at 
150dpi.

7.3.1.8 Scan Colour 200dpi

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Colour images at 
200dpi.

7.3.1.9 Scan Double sided

Would would discard the barcode 
sheet and switch the scanner setup 
to start scanning Double sided im-
ages.

7.3.1.10 Scan Greyscale 
150dpi

Would would discard the barcode 
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OCR on Scan’

7.4 Dictionaries & Spelling 

Dictionaries and Spelling (see 
fig. 7.4) settings can be specific 
to project or even to a field.  It is 
possible to set each field to have 
a separate custom dictionary and 
to be spell checked to a different 
language dictionary.  

7.4.1 Custom Dictionaries

If any text field in a project is set 
to be spell checked then a custom 
dictionary must be created.

Select ‘Custom’ and then ‘Create 
Custom Dictionary’ from the  con-
text menu.  

Custom dictionaries can be created 
for a project or a specific field or 
group of fields.

Give the custom dictionary a logical 
name (i.e. if by project then the 
dictionary could be called by the 
project name, if for a specific field 
then use the field name)

Once created it can be selected 
at the point of configuring the text 
field (see section 7.1.2.1.6). 

7.4.2 Spelling Queries

During Indexing any field marked 
for Spell Checking containing a 

OCR on Scan’

7.4 Dictionaries & Spelling 

Dictionaries and Spelling (see 
fig. 7.4) settings can be specific 
to project or even to a field.  It is 
possible to set each field to have 
a separate custom dictionary and 
to be spell checked to a different 
language dictionary.  

fig. 7.3.2 Assigning barcodes to 
index fields

Select ‘Custom’ and then ‘Create 
Custom Dictionary’ from the  con-
text menu.  

Custom dictionaries can be created 
for a project or a specific field or 
group of fields.

Give the custom dictionary a logical 
name (i.e. if by project then the 
dictionary could be called by the 
project name, if for a specific field 

fig. 7.4 Dictionaries & Spelling
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word not in the dictionary will re-
quire the indexer to:

7.4.2.1. Change the spelling

This will simply allow a change to 
the spelling by selecting from a list 
or by making the correction and 
then selecting Change.  This action 
will mark nothing in the dictionary 
pending list.

7.4.2.2. Ignore Once

This will add the word to the 
Pending list but will only allow the 
indexer to continue past this one 
instance of the spelling.

7.4.2.3. Ignore All

This will add the word to the Pend-
ing list for each and every instance 
of the word but not ask the indexer 
for confirmation each time.

7.4.3 Pending

Any field set up to be Spell
Checked, will flag queries during
Indexing,  Ignore or Ignore All will 
add each and every instance of the 
word flagged to the Pending list
(see fig.7.4 and 7.4.3).

Data cannot be Exported until 
these words have been authorised 
or rejected by the designated user. 

All words are listed with their loca-
tion, i.e. consignment, batch, docu-
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ment, page and the field in which 
the word is contained.

Any word displayed in this list can 
be:

- Approved 
- Added to the dictionary
- Rejected 
NB as soon as the original word is 
accessed again in indexing all cur-
rent related rejects will be removed 
and the word reassessed.

7.4.3.1. Approve

Any word marked during indexing 
as ‘Ignore’ or ‘Ignore All’ can  be 
assessed in Manager as Approved, 
removing it from the Spelling Pend-
ing Queries list.  

This word will not be added to the 
dictionary and will be queried again 
if used in another batch.

7.4.3.2 Reject

Any word rejected at this stage 
will be added to the Rejected list-
ing and should be followed up for 
investigation and correction before 
any export is attempted.

7.4.4. Editing the Custom 
Dictionary

This dictionary can be examinied 
and  corrected at any time by se-
lecting the specific custom diction-
ary and and word.  

Any word marked during indexing 
as ‘Ignore’ or ‘Ignore All’ can  be 
assessed in Manager as Approved, 
removing it from the Spelling Pend-
ing Queries list.  

This word will not be added to the 
dictionary and will be queried again 
if used in another batch.

fig. 7.4.3 Pending list

ment, page and the field in which 
the word is contained.

Any word displayed in this list can 
be:

fig. 7.4 Dictionaries & Spelling
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Use the context menu to make any 
necessary changes (see fig. 7.4.4).

7.4.4.1 Add Word

Any word can be added directly 
into the dictionary.  Once entered, 
it is listed in edit mode to allow 
confirmation of the entry.

7.4.4.2 Import Words

A comma delimited text file can be 
imported to add required special-
ist words relevant to the specific 
project or project field.

7.4.4.3 Edit Word

Selecting edit word allows the user 
to correct a spelling error.

7.4.4.4 Remove Word

This will remove the word from the 
custom dictionary and if re-entered 

confirmation of the entry.

7.4.4.2 Import Words

A comma delimited text file can be 
imported to add required special-
ist words relevant to the specific 
project or project field.

7.4.4.3 Edit Word

Selecting edit word allows the user 
to correct a spelling error.

fig. 7.4.4 Editing the custom 
dictionary
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in indexing will raise it as a spelling 
query.

8 Working with 
Deliveries
Permissions 4.3.1

A Delivery is classed as one or 
more groups of documents for 
a single project, delivered at the 
same time, to the image process-
ing area. 

A number of Deliveries can be cre-
ated in any one day,  the details of 
which may be edited at any time.  

8.1 Options via context 
menu

A number of options can be se-
lected from the context menu (see 
fig.8.1)

8.1.1 Select Columns

The displayed columns can be 
selected using the context menu 
<Select Columns> (see fig. 8.1.1).

NB there is no necessity to display 
columns containing no data, i.e. the 
data was not set in Project creation 
to be collected.

8.1.2 New Delivery

Select the required project and 
<Deliveries>.  Select <New 
Delivery> from the context menu to 

8.1 Options via context 
menu

A number of options can be se-
lected from the context menu (see 
fig.8.1)

8.1.1 Select Columns
fig. 8.1.1 Deliveries column selection

8.1.2 New Delivery

Select the required project and 
<Deliveries>.  Select <New 

fig. 8.1.2.1 Deliveries configuration 
screen minimum details

in indexing will raise it as a spelling 
query.

8 Working with 
Deliveries
Permissions 4.3.1

A Delivery is classed as one or 
more groups of documents for 
a single project, delivered at the 

fig. 8.1 Deliveries  context options
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display the delivery configuration 
window (see fig. 8.1.2.1).  

The default settings for delivery 
name, number, date and time are 
automatically entered but can be 
edited if required.

 NB. For example; the delivery ar-
rived late the previous day, the date 
can be adjusted to reflect this.

This entry screen can be set up 
within the project configuration to 
require a number of details to be 
entered (see section 6.3).  

Figure 8.1.2.2 shows the maximum 
information that could be required.

8.1.3 Edit Delivery
Permissions 4.3.1

This option will re-display the Deliv-
ery configuration screen to enable 
any detail to be altered.

8.1.4 Remove Delivery
Permissions 4.3.1

This will allow a delivery to be 
removed providing that it contains 
no images.

A delivery containing images can-
not be removed until all the con-
tents of that delivery have been 
removed (i.e. all batches under that 
delivery).

8.1.5 Archive/UnArchive 
Delivery
Permissions 4.1.1

display the delivery configuration 
window (see fig. 8.1.2.1).  

The default settings for delivery 
name, number, date and time are 
automatically entered but can be 
edited if required.

This entry screen can be set up 
within the project configuration to 
require a number of details to be 
entered (see section 6.3).  fig. 8.1.2.2 Deliveries configuration 

screen maximum details
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Archiving a delivery will keep the 
delivery on the system but remove 
it from the display in Capsure.

Archiving is used where a delivery 
may be required at a later date,  
but has been deemed completed 
and exported at the current time.

It is displayed within Capsure Man-
ager in Light Grey (see fig. 8.1.5)

Archiving a Delivery will archive all 
Consignments and Batches con-
tained within that Delivery.  

UnArchiving reverses this proce-
dure.

8.1.6 FastTrack/UnFastTrack 
Delivery
Permission 4.3.2

FastTracking is for urgently re-
quired work which should therefore 
be processed ahead of any other 
non-Fast Tracked work. 

The delivery is displayed in a 
separate Batch Browser above the 
standard one within Capsure (see 
fig. 8.1.6.2) to bring it to the users 
attention for immediate processing.

It is displayed within Capsure Man-
ager in Red (see fig. 8.1.6.1)

FastTracking a Delivery will fast-
track all Consignments and Batch-

Archiving a delivery will keep the 
delivery on the system but remove 
it from the display in Capsure.

Archiving is used where a delivery 
may be required at a later date,  
but has been deemed completed Fig. 8.1.5 - Delivery Status

Delivery 1 Archived

It is displayed within Capsure Man-
ager in Light Grey (see fig. 8.1.5)

Archiving a Delivery will archive all 
Consignments and Batches con-
tained within that Delivery.  

UnArchiving reverses this proce-Fig. 8.1.6.1 - Delivery Status
Delivery 5 Fasttracked

Fig. 8.1.6.2 - FastTrack display within 
Capsure
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es contained within that Delivery. 

UnFastTracking will reverse this 
procedure.

8.1.7 Activate/Deactivate 
Delivery

Deactivate Delivery is used when 
processing has started on the de-
livery but cannot be continued for 
any reason.

For example, the documents are 
required elsewhere but will be 
returned at a later date to continue 
the process.

It is displayed within Capsure 
Manager in Meduium Grey (see fig. 
8.1.7).

Deactivating a Delivery will deacti-
vate all Consignments and Batches 
contained within that Delivery and 
will not be displayed within Cap-
sure.

Reactivate Delivery reverses this 
procedure.

8.1.8 Print Report

Reports can be printed at any 
time from within Capsure Manager 
rather than having to open Report 
Viewer and select the required 
criteria.

Select the required report from the 
Report Selection screen (see fig. 
8.1.8) which will show all previously 
created reports (see Reporting 

Deactivate Delivery is used when 
processing has started on the de-
livery but cannot be continued for 
any reason.

For example, the documents are 
required elsewhere but will be 

Fig. 8.1.7 - Delivery Status
Delivery 3 Deactivated 

Deactivating a Delivery will deacti-
vate all Consignments and Batches 
contained within that Delivery and 
will not be displayed within Cap-
sure.

Reactivate Delivery reverses this 
procedure.

8.1.8 Print Report

Reports can be printed at any 
time from within Capsure Manager Fig. 8.1.8 - Report Selection
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Manual).

The report will be printed for all 
consignments and batches within 
the delivery.

9 Working with 
Consignments

A Consignment is a logical split of a 
delivery, for example 

- 1 box of a multi box delivery
- 1 set of multi-volume files
- A group of drawings of a similar 
size

A delivery may contain one or 
many consignments

9.1 Options via context 
menu

A number of options can be se-
lected from the context menu (see 
fig.9.1)

9.1.1 Select Columns

The displayed columns can be 
selected using the context menu 
<Select Columns> (see fig. 9.1.1).

NB Only columns deemed of interest 
need be displayed, i.e. if the creation 
date for the consignment is the same 
creation date as the delivery..

9.1.2 Create new 
Consignment

The report will be printed for all 
consignments and batches within 
the delivery.

9 Working with 
Consignments

A Consignment is a logical split of a 
delivery, for example 

A delivery may contain one or 
many consignments

9.1 Options via context fig. 9.1 Consignment context menu 
options

A number of options can be se-
lected from the context menu (see 
fig.9.1)

9.1.1 Select Columns

The displayed columns can be 
selected using the context menu 
<Select Columns> (see fig. 9.1.1).

fig. 9.1.1 Consignment context menu 
options
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Select the project and delivery.  
Select <Add Consignment(s)> from 
the context menu options (see 
fig.9.1.2.1 & 9.1.2.2).

Creating or Editing individual 
consignments will allow the user to 
add a comment (see fig. 9.1.2.1) 
whereas adding multiply consign-
ments does not.

Comments can be added after 
adding multiple consignments by 
editing the individual consignments  
(see fig. 9.1.2.2).

9.1.3 Edit Consignment
Permission 4.3.4

This option will display the Con-
signment configuration screen to 
enable any detail to be altered.

9.1.4 Remove Consignment
Permissions 4.3.1

This will allow a consignment to be 
removed providing that it contains 
no images.

A consignment containing images 
cannot be removed until all the 
contents of that consignment have 
been removed.

 (i.e. all batches under that con-
signment).

9.1.5 Archive/UnArchive 
Consignment
Permission 4.3.1

Select the project and delivery.  
Select <Add Consignment(s)> from 
the context menu options (see 
fig.9.1.2.1 & 9.1.2.2).

Creating or Editing individual 
consignments will allow the user to 
add a comment (see fig. 9.1.2.1) 
whereas adding multiply consign-
ments does not.

adding multiple consignments by 
editing the individual consignments  
(see fig. 9.1.2.2).

9.1.3 Edit Consignment
Permission 4.3.4

This option will display the Con-
signment configuration screen to 

fig. 9.1.2.1 Consignment 

fig. 9.1.2.2 Add multiple 
consignments
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Archiving is used to maintain a 
consignment on the system, i.e. will 
be required at a later date, but has 
been completed and exported at 
the current time. 

Archiving a consignment will 
remove that consignment from the 
display in Capsure.

It is displayed within Capsure Man-
ager in Light Grey (see fig. 9.1.5)

Archiving a Consignment will ar-
chive all Batches contained within 
that Consignment.

UnArchiving will reverse this pro-
cedure.

9.1.6 FastTrack/UnFastTrack 
Consignment
Permission 4.3.2

FastTracking is used when a con-
signment requires urgent process-
ing. 

The consignment is displayed in 
a separate Batch Browser above 
the standard one within Capsure to 
prompt immediate handling.

It is displayed within Capsure Man-
ager in Red (see fig. 9.1.3)

Fig. 9.1.5 - Consignment Status
Consignment 11 Archived
Consignment 15 FastTracked

chive all Batches contained within 
that Consignment.

UnArchiving will reverse this pro-
cedure.

9.1.6 FastTrack/UnFastTrack 
Consignment
Permission 4.3.2

FastTracking is used when a con-
signment requires urgent process-
ing. 

The consignment is displayed in 
a separate Batch Browser above 
the standard one within Capsure to 
prompt immediate handling.

It is displayed within Capsure Man-
ager in Red (see fig. 9.1.3)

Fig. 9.1.6 - FastTracked consignment 
displayed in Capsure
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FastTracking a Consignment will 
FastTrack all Batches contained 
within that Consignment.  

UnFastTracking will reverse this 
procedure.

9.1.7 Activate/Deactivate 
Consignment

Deactivate Consignment is  used 
when processing has been started 
on the Consignment but must be 
halted for whatever reason.

For example, the documents are 
required elsewhere but will be 
returned at a later date to continue 
the processing.

It is displayed within Capsure 
Manager in Meduium Grey (see fig. 
9.1.7).

Deactivating a Consignment will 
deactivate all Batches contained 
within that Consignment.

Reactivate Consignment reverses 
this procedure.

9.1.8 Print Report

Reports can be printed at any 
time from within Capsure Manager 
rather than having to open Report 
Viewer and select the required 
criteria.

Select the required report from the 
Report Selection screen (see fig. 
9.1.8) which will show all previously 
created reports (see Reporting 

procedure.

9.1.7 Activate/Deactivate 
Consignment

Deactivate Consignment is  used 
when processing has been started 
on the Consignment but must be 

Fig. 9.1.7 - Consignment Status
Consignment 13 De-Activated

9.1.7).

Deactivating a Consignment will 
deactivate all Batches contained 
within that Consignment.

Reactivate Consignment reverses 
this procedure.

9.1.8 Print Report

Reports can be printed at any 
time from within Capsure Manager 
rather than having to open Report 

Fig. 9.1.8 - Report Selection
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Manual).

The report will be printed for all 
consignments and batches within 
the delivery.

10 Working with 
Batches
Permission 4.3.1

A Batch is a logical split of a con-
signment, for example 

- 1 file of a multi-volume set
- 1 folder from within a box

A batch may contain one or many 
documents.

10.1 Options via context 
menu

A number of options can be se-
lected from the context menu (see 
fig. 10.1)

10.1.1 Select columns

The displayed columns can be 
selected using the context menu 
<Select Columns> (see fig. 10.1.1)

NB there is no necessity to display 
columns deemed of no interest, i.e. 
the creation date for the batch if this 
is the same creation date as the 
delivery.

10.1.2 Create new Batch

the delivery.

10 Working with 
Batches
Permission 4.3.1

fig. 10.1 Batch context options

A batch may contain one or many 
documents.

10.1 Options via context 
menu

A number of options can be se-
lected from the context menu (see 

fig. 10.1.1 Batch column options
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Select required project, deliv-
ery and consignment.  Select 
<Add Batch(s)> from the context 
menu options (see fig.10.1.2.1 & 
10.1.2.2).

Creating or Editing individual 
batches allows the user to add a 
comment unique to that batch (see 
fig. 10.1.2.1).

To add comments after adding 
multiple batches (see fig. 10.1.2.2) 
would require the individual batch-
es to be Edited .

Batches may be selected and 
edited or marked via the context 
menu (see fig. 10.1.3).

10.1.3 Edit Batch
Permission 4.3.4

This will display the batch configu-
ration screen as long as the user 
has permission to access batches.

10.1.4 Remove Batches
Permission 4.3.4

A batch containing images may 
only be removed by users with the 
correct permissions.

10.1.5 Archive/UnArchive 
Batches
Permission 4.3.1

Archiving is used where the batch 
is still required to be kept on the 
system i.e. will be required at a 

Select required project, deliv-
ery and consignment.  Select 
<Add Batch(s)> from the context 
menu options (see fig.10.1.2.1 & 
10.1.2.2).

Creating or Editing individual 
batches allows the user to add a 
comment unique to that batch (see 
fig. 10.1.2.1).

would require the individual batch-
es to be Edited .

Batches may be selected and 
edited or marked via the context 
menu (see fig. 10.1.3).

10.1.3 Edit Batch
Permission 4.3.4

fig. 10.1.2.1 Add single batch

fig. 10.1.2.2 Add multiple batches
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later date, but has been completed 
and exported at the current time.

Archiving a batch will remove that 
batch from the display in Capsure .

It is displayed within Capsure 
Manager in Light Grey (see fig. 
10.1.5).  UnArchiving will reverse 
this procedure.

10.1.6 FastTrack/UnFastTrack 
Batches
Permission 4.3.2

FastTracking is used when a batch 
requires immediate processing. 

The batch is displayed in a sepa-
rate Batch Browser above the 
standard one within Capsure to 
highlight this requirement.

It is displayed within Capsure Man-
ager in Red (see fig.10.1.4)

UnFastTracking will reverse this 
procedure.

10.1.7 Activate/Deactivate 
Batch

Deactivate Batch is  used when 
processing has been started on 
the Batch but must be halted for 
whatever reason.

For example, the documents are 
required elsewhere but will be 
returned at a later date to continue 

It is displayed within Capsure 
Manager in Light Grey (see fig. 
10.1.5).  UnArchiving will reverse 
this procedure.

10.1.6 FastTrack/UnFastTrack 
Batches
Permission 4.3.2

Fig. 10.1.5 - Batch Status
Batch 3 Archived
Batch 7 Fasttracked

It is displayed within Capsure Man-
ager in Red (see fig.10.1.4)

UnFastTracking will reverse this 
procedure.

10.1.7 Activate/Deactivate 
Batch

Fig. 10.1.7 - Batch Status
Batch 5 - De-activated
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10.1.8 Print Report

Reports can be printed at any 
time from within Capsure Manager 
rather than having to open Report 
Viewer and select the required 
criteria.

Select the required report from the 
Report Selection screen (see fig. 
10.1.8) which will show all previ-
ously created reports (see Report-
ing Manual).

The report will be printed for all 
consignments and batches within 
the delivery.

10.1.8 Print Report

Reports can be printed at any 
time from within Capsure Manager 
rather than having to open Report 
Viewer and select the required 
criteria.

Select the required report from the 
Report Selection screen (see fig. 
10.1.8) which will show all previ-
ously created reports (see Report-
ing Manual).

Fig. 10.1.8 - Report Selection
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the process.

It is displayed within Capsure 
Manager in Meduium Grey (see fig.
10.1.7).

Re-activate Batch reverses this 
procedure.

11 Export Checks

Export checks are used to validate  
the data and images, ensuring that 
nothing should fail at the time of 
exporting.

11.1 Creating Export 
Checks

Select the Project Group and 
Project, Exporting, Export Checks 
and, from the context menu, <Add 
Check> to display the Export 
Check Configuration window (see
Figure 11.1).

There are a number of checks 
that can be selected (see sections 
11.1.1 - 11.1.8).

11.1.1 Field Numbering

Field numbering can be checked to 
ensure that a number at the begin-
ning of the configured field either
increments or remains the same 
from one document to the next.

The number can be in a variety of 
forms (e.g. ‘1’, ‘1.1’,’1.1.1.1’). 

Fig.11.1 Export Check configuration
screen
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The separator can be any entered 
character (e.g. stop, hyphen, 
space, or any combination ‘1-1.1’).

Selecting the Field Numbering 
Check from the list will display a 
further configuration screen (see
Figure 11.1.1).

Select the field name to be
checked from the list box.  Ensure 
that the separator to be used is 
present in the <Allowed Separator> 
box.

Tick the required choices from the 
options.

11.1.1.1 Numbers must 
increment

This will not allow numbers to 
remain the same.  Each indexed 
number in the configured field must
be greater than the previous index.

For example - 1.1 can be followed 
by 1.3 but not by 1.1 

11.1.1.2 Allow initial missing 
numbers

The first one or few records at the
beginning of a batch need not have 
a number at the start of the index 

data.

i.e. The first record may be ‘(Index)’
followed by ‘01 General Docu-
ments’.

Once started, all following records 
must be numbered.

11.1.2 Multi Field Numbering

This check will ensure that a 
number at the beginning of the 
configured fields increments
or remains the same from one 
document to the next (see Figure 
11.1.2).

The Multi Field Numbering check 
will allow sub fields to be in se-
quence as well. For example, 
where three numbered fields are
indexed

Doc. 1
Category 1 = 01 General
Category 2 = 1 Legal
Category 3 = 1 XYZ

Doc. 2
Category 1 = 01 General
Category 2 = 1 Legal
Category 3 = 2 ABC

This check will ensure that the 
combination of all three fields will
increment i.e. doc 1 = 01.1.1 and 
doc 2 = 01.1.2.
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Up to five fields can be linked in
this way.

It is also possible to check that 
these combined ‘Numbers must 
Increment’ (see section 11.1.1.1) 
and ‘Allow Initial Missing Numbers’ 
(see section 11.1.1.2)

11.1.3 First Page Bookmark

This checks that every page book-
marked as a first page is indexed
as a first page.

The bookmark may be as a result 
of a ‘New Document’ barcode used 
during scanning or by being a first
page of an imported document

11.1.4 First page Index

This check ensures that the first
page of a document or a batch is 
indexed.  Missing indicies prevent it 
being defined as a document.

11.1.5 Image Assessment

This check  ensures that every 
page is assessed as either Good, 
Bad or Deleted.  Any other assess-
ment (i.e. Rescan) will be reported.

11.1.6 Image

This  ensures that a physical image 
exists for every page of the expect-
ed document(s).

11.1.7 Mandatory Field

This will check that all mandatory 
fields for all indexed pages have
been filled in.

Whilst this is checked during index-
ing it may be possible for a hard-
ware failure (i.e. unexpected power 
cut) to cause the check during 
indexing to fail

11.1.8 Spelling Queries

If fields have been set to be Spell
checked, all the Spelling Queries 
(see section 7.4.2) must have been 
reviewed and accepted or rejected 
and replaced.

This will ensure that no pending or 
rejected spelling queries still exist 
for the exporting data.

11.1.9 Task Complete

All tasks must be marked off as 
completed by using Accept Task to 
close the individual modes.

Any batch closed with ‘Stop Task’ 
will cause this check to fail.
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11.2 Running Export 
Checks

Export Validation  runs through the 
Export Checks one by one and is 
initiated from the main Capsure 
module.

12 Export Set up

Exporting is the means to convert  
data and/or images into the re-
quired format.

Select ‘Exports’ from the required 
Project - Exporting,  and <Add 
Export> from the context menu to 
display the Export  Configuration 
window (see Figure 12.0.1).

Enter a logical name for the Export, 
i.e. Customer name or type of out-
put - e.g. TIFF export.

Edit or replace the description to 
something meaningful (more than 
one export can be performed on 
the same data) e.g. ‘This will export 
documents as multipage TIFF with 
index data per consignment’. 

Select the type of export required 
(see section 12.1) and then select 
the <Configure> button to display 
the selection screen for exports.

Exports can be configured in a 
variety of ways (see fig. 12.0.2) but 
will only be saved when exiting the 
export set up via <OK>.

Checks

Export Validation  runs through the 
Export Checks one by one and is 
initiated from the main Capsure 
module.

12 Export Set up

Exporting is the means to convert  
data and/or images into the re-Fig.12.0.1 Export configuration 

screen

one export can be performed on 
the same data) e.g. ‘This will export 
documents as multipage TIFF with 
index data per consignment’. 

Select the type of export required 
(see section 12.1) and then select 
the <Configure> button to display 
the selection screen for exports.

Exports can be configured in a 
variety of ways (see fig. 12.0.2) but 
will only be saved when exiting the 
export set up via <OK>.

Fig.12.1.1 Setup selection screen

Select ‘Exports’ from the required 
Project - Exporting,  and <Add 
Export> from the context menu to 
display the Export  Configuration 
window (see Figure 12.0.1).

Enter a logical name for the Export, 
i.e. Customer name or type of out-
put - e.g. TIFF export.

Fig.12.0.2 Select type of export
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12.1 Type of export - 
Custom

Selecting Custom Export and 
<Configure> will display the setup 
selection screen (see fig. 12.1.1)

12.1.1 Folders

The folder structure for the export-
ed images must be created before 
any formatting of the output can be 
configured.  

Select Folders from the Custom 
Export selection screen to display 
the folder setup screen (see fig. 
12.1.1.1).

Enter the Root Export Path re-
quired.  The default path will place 
the images under C:\Capsure Ex-
port.  This may be set to any drive 
on the network and any path.  The 
path will be created when the first 
export is run.

Select the first folder level ‘Export’ 
to structure the folders under the 
root export path.

Select <Add> to display the Select 
Custom String setup (see fig. 
12.1.1.2).  A folder name can be 
constructed from entered text, 
contents of index fields or standard 
data.  Creating a Custom String al-
lows any combination of elements 
to be used to create the folder 
name.

Custom

Selecting Custom Export and 
<Configure> will display the setup 
selection screen (see fig. 12.1.1)

12.1.1 Folders

The folder structure for the export-
ed images must be created before 
any formatting of the output can be 
configured.  

Fig.12.1.1.1 Folder setup screen

the folder setup screen (see fig. 
12.1.1.1).

Enter the Root Export Path re-
quired.  The default path will place 
the images under C:\Capsure Ex-
port.  This may be set to any drive 
on the network and any path.  The 
path will be created when the first 
export is run.

Select the first folder level ‘Export’ 

Select <Add> to display the Select 
Custom String setup (see fig. 
12.1.1.2).  A folder name can be 
constructed from entered text, 
contents of index fields or standard 
data.  Creating a Custom String al-
lows any combination of elements 
to be used to create the folder 
name.

Fig.12.1.1.3 New Custom String

Fig.12.1.1.2 Custom String
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Select <New> to create a Custom 
String (see fig.12.1.1.3).  Enter a 
logical name e.g. Project name, 
and right click in the String en-
try box following the instructions 
displayed to enter the elements 
required to make up the string.

Holding the mouse cursor over an 
element will display the format set 
(see fig. 12.1.1.4).

Several levels of folders can be 
constructed.  These levels can 
be edited or removed until  eve-
rything is set up as required. (see 
fig.12.1.1.5).  

In the example shown, the images 
will be exported to C:\Capsure 
Exports\Project name\Consign-
ment number where Project name 
and Consignment number will be 
inserted at the time of export.

Click <ok> to return to the Custom 
Export set up screen (fig.12.1.1).

12.1.2 Images

Images can be exported as one of 
three formats if the required licens-
es are installed.  See fig. 12.1.2

Each format has unique configura-
tion settings.

12.1.2.1 Multi page TIFF

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).

Select <New> to create a Custom 
String (see fig.12.1.1.3).  Enter a 
logical name e.g. Project name, 
and right click in the String en-
try box following the instructions 
displayed to enter the elements 
required to make up the string.

Holding the mouse cursor over an 
element will display the format set 
(see fig. 12.1.1.4).

Fig.12.1.1.4 Element format

constructed.  These levels can 
be edited or removed until  eve-
rything is set up as required. (see 
fig.12.1.1.5).  

In the example shown, the images 
will be exported to C:\Capsure 

Fig.12.1.1.5 Folder structure

ment number
and Consignment number will be 
inserted at the time of export.

Click <ok> to return to the Custom 
Export set up screen (fig.12.1.1).

12.1.2 Images

Images can be exported as one of 
three formats if the required licens-Fig.12.1.2 Image settings
es are installed.  See fig. 12.1.2

Each format has unique configura-
tion settings.

12.1.2.1 Multi page TIFF

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).Fig.12.1.2.1.1 Image settings
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Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list, (see fig.12.1.2.1.1).

Click the browse button (...) to cre-
ate a filename custom string for the 
documents.  

Remember to add the extension 
to the name (i.e. Invoice number.
tif where Invoice number is created 
from the index field for each docu-
ment.

The Format and Advanced tabs are 
set to a default standard but can 
be edited if the end user requires a 
specific structure for the TIFF im-
ages. (see figs. 12.1.2.1.2 & 3)

12.1.2.2 Multipage PDF

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list, (see fig.12.1.2..1).

Click the browse button (...) to cre-
ate a filename custom string for the 
documents.  

Remember to add the extension to 
the name (i.e. Invoice number.pdf 
where Invoice number is created 
from the index field for each docu-
ment.

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list, (see fig.12.1.2.1.1).

Click the browse button (...) to cre-
ate a filename custom string for the 
documents.  

The Format and Advanced tabs are 
set to a default standard but can 
be edited if the end user requires a 
specific structure for the TIFF im-
ages. (see figs. 12.1.2.1.2 & 3)

12.1.2.2 Multipage PDF

The location tab is common to all 

Fig.12.1.2.1.2 Tiff format tab

Fig.12.1.2.1.3 Tiff advanced tab

Custom Strings (see section 12.1.1 
Folders).

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list, (see fig.12.1.2..1).

Click the browse button (...) to cre-
ate a filename custom string for the 
documents.  

Fig.12.1.2.2.1 Tiff advanced tab
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Fig.12.1.2.2.2 PDF advanced tab

Fig.12.1.2.2.3 PDF Format tab

Fig.12.1.2.2.4 PDF JPEG tab

Fig.12.1.2.2.5 PDF JBig2 tab
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The Format, Advanced, JPEG 
and JBig2 tabs are set to a default 
standard but can be edited if the 
end user requires a specific struc-
ture for the PDF images. (see figs. 
12.1.2.2.2,3,4&5)

12.1.2.3 Abbyy 6 format

Abbyy6 format is used when the 
images are required to be OCRd 
(pass through Optical Character 
Recognition) to produce an image 
and/or text.

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list, (see fig.12.1.2.3.1).

Click the browse button (...) to cre-
ate a filename custom string for the 
documents.  

Remember to add the extension to 
the name (i.e. Invoice number.pdf 
where Invoice number is created 
from the index field for each docu-
ment.

The Info tab (see fig 12.1.2.3.2) 
allows  preset information to be 
stored in the image header.  Using 
the Browse button (...) creates cus-
tom strings from available data.

The Image tab (see fig.12.1.2.3.3) 
will set the output image resolu-
tion (dots per inch) irrespective of 

The Format, Advanced, JPEG 
and JBig2 tabs are set to a default 
standard but can be edited if the 
end user requires a specific struc-
ture for the PDF images. (see figs. 
12.1.2.2.2,3,4&5)

12.1.2.3 Abbyy 6 format

Abbyy6 format is used when the 
images are required to be OCRd 
(pass through Optical Character 
Recognition) to produce an image Fig.12.1.2.3.1 Abbyy6 Location tab

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list, (see fig.12.1.2.3.1).

Click the browse button (...) to cre-
ate a filename custom string for the Fig.12.1.2.3.2 Abbyy6 Info tab

The Info tab (see fig 12.1.2.3.2) 
allows  preset information to be 
stored in the image header.  Using 
the Browse button (...) creates cus-
tom strings from available data.

The Image tab (see fig.12.1.2.3.3) Fig.12.1.2.3.3 Abbyy6 Image tab
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whether the scanned or imported 
images were variable dpi.  It is suf-
ficient for most purposes to set this 
to 200dpi.

No other settings on this tab need 
be set.

The OCR tab (see fig. 12.1.2.3.4) 
is the main configuration setup for 
OCR’d PDFs.  Select the check 
box ‘Enable OCR’ and check the 
PDF style required.

Select the language(s) to be used.
The more languages used the slower 
the OCR processing.

If the documents contain plans and 
therefore little data that could be 
usefully OCRd, check the box ‘Do 
not OCR pages over..’ and select 
the size required (commonly set to 
A3)

The Advanced tab (see fig. 
12.1.2.3.5) is set to a default stand-
ard but can be edited if the end 
user requires a specific structure 
for the PDF images.

12.1.3 Data

Select data and, from the list box, 
select <Advanced Text Export’ (see 
fig. 12.1.3).  Click the <Configure> 
button to display the four tabs.

The output of the data can be 
formatted in a variety of ways - see 
sections 12.1.3.5 - 12.1.3.8)

images were variable dpi.  It is suf-
ficient for most purposes to set this 
to 200dpi.

No other settings on this tab need 
be set.

The OCR tab (see fig. 12.1.2.3.4) 
is the main configuration setup for 
OCR’d PDFs.  Select the check 
box ‘Enable OCR’ and check the 
PDF style required.

Fig.12.1.2.3.4 Abbyy6 OCR tab

If the documents contain plans and 
therefore little data that could be 
usefully OCRd, check the box ‘Do 
not OCR pages over..’ and select 
the size required (commonly set to 
A3)

The Advanced tab (see fig. Fig.12.1.2.3.5 Abbyy6 Advanced tab

ard but can be edited if the end 
user requires a specific structure 
for the PDF images.

12.1.3 Data

Select data and, from the list box, 
select <Advanced Text Export’ (see 
fig. 12.1.3).  Click the <Configure> 
button to display the four tabs.

The output of the data can be Fig.12.1.3 Data export
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12.1.3.1 Location tab

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list (see fig 12.1.3.1)

Click the browse button (...) to cre-
ate a filename custom string for the 
documents.  

Remember to add the extension to 
the name.

(i.e. Consignment number.txt)

12.1.3.2 Header tab

The header tab is used to add 
information before the main index 
data where required, either per 
Export Batch or per Document (see 
fig. 12.1.3.2.1).  

The content of the header can be 
made up of:

- Any text
- Standard Fields
- Indexed Fields
- Custom Strings
- Special Characters

Special Characters are displayed 
as text to ensure that there is no 
confusion, i.e. Selecting Newline 
with the <Enter> key will display 
{Newline}, space will display 
{Space}, “ will display {Dou-

The location tab is common to all 
image and data formats and uses 
Custom Strings (see section 12.1.1 
Folders).

Ensure that the Folder location 
is set to the correct level using 
the down arrow to select from the 
available list (see fig 12.1.3.1)

Click the browse button (...) to cre-Fig.12.1.3.1 Data - location tab

documents.  

12.1.3.2 Header tab

The header tab is used to add 
information before the main index 

Fig.12.1.3.2.1 Data - header tab

Fig.12.1.3.2.2 Data - header tab
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bleQuotes} etc. (See fig.12.1.3.2.2)

Header data is required by some 
Document Management systems to 
ensure that the DM system knows 
what data to put in which field.  

It can also be used as Column 
headers to text outputs into soft-
ware such as MS Excel.

This data may be as simple or as 
complex as is required.

12.1.3.3 Footer tab

The Footer tab is used to add in-
formation after the main index data 
where required, either per Export 
Batch or per Document (see fig. 
12.1.3.3.1).  

The content of the footer can be 
made up of:

- Any text
- Standard Fields
- Indexed Fields
- Custom Strings
- Special Characters

Special Characters are displayed 
as text to ensure that there is no 
ambiguity, i.e. Usingthe <Enter> 
key will display {Newline}, space 
will display {Space}, “ will display 
{DoubleQuotes} etc.

Footer data is required by some 
Document Management systems to 

Header data is required by some 
Document Management systems to 
ensure that the DM system knows 
what data to put in which field.  

It can also be used as Column 
headers to text outputs into soft-
ware such as MS Excel.

This data may be as simple or as 
Fig.12.1.3.3.1 Data - footer tab
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ensure that the DM system knows 
where data for each document or 
group of documents finishes.  

This data may be as simple or as 
complex as is required.

12.1.3.4 Body Tab

The Body tab is used to create 
the output text file containing the 
indexed information and can be ei-
ther per Document, Page or Export 
Batch.

Data is most commonly required 
per document but could be unique 
per page.

The content of the body data (see 
example shown in fig. 12.1.3.4.1) 
can be made up of:

- Any text
- Standard Fields
- Indexed Fields
- Custom Strings
- Special Characters

Special Characters are displayed 
as text to ensure that there is no 
confusion, i.e. Selecting Newline 
with the <Enter> key will display 
{Newline}, space will display 
{Space}, “ will display {Dou-
bleQuotes} etc.

This data may be as simple or as 
complex as is required but must 
match the end user’s specifica-
tion, where provided, to enable the 
data and images to upload to their  
system.

where data for each document or 
group of documents finishes.  

This data may be as simple or as 
complex as is required.

12.1.3.4 Body Tab

The Body tab is used to create 
the output text file containing the 

Batch.

Data is most commonly required 
per document but could be unique 
per page.

The content of the body data (see 
example shown in fig. 12.1.3.4.1) 
can be made up of:

Fig.12.1.3.4.1 Data - Body tab

Fig.12.1.3.5.1 Current Date format

Special Characters are displayed 
as text to ensure that there is no 
confusion, i.e. Selecting Newline 
with the <Enter> key will display 
{Newline}, space will display 
{Space}, “ will display {Dou-
bleQuotes} etc.

This data may be as simple or as 
complex as is required but must 
match the end user’s specifica-
tion, where provided, to enable the 
data and images to upload to their  
system.

Fig.12.1.3.5.1 Date format
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12.1.3.5 Formatting the date

Date fields are only entered in the 
format Day/Month/Year but can be 
output in a variety of ways.  

Position the cursor over the date 
field to see the existing format (see 
fig. 12.1.3.5.1).

Select the date to be formatted to 
display the Custom String Format 
window.  The example shown in 
fig.12.1.3.5.2 gives an idea of the 
flexibility of the formatting.

12.1.3.6 Formatting text

Textural data can be Trimmed 
(fig.12.1.3.6.1) Justified 
(fig.12.1.3.6.2) or have data re-
placed within it (see fig.12.1.3.5.3).

12.1.3.6.1 Trimming 

Allows the user to extract sections 
of the data entered where required.  
This can be starting from the:

- beginning of the data
- end and counting backwards
- from a specific start point for a 
defined number of character

12.1.3.6.2 Justification & Padding

Data can be padded to a specific 
number of characters and justified 
left or right (inserting leading or 
trailing spaces).

12.1.3.6.3 Replaces

12.1.3.5 Formatting the date

Date fields are only entered in the 
format Day/Month/Year but can be 
output in a variety of ways.  

Position the cursor over the date 
field to see the existing format (see 
fig. 12.1.3.5.1).

Select the date to be formatted to Fig.12.1.3.6.1 Text format - Trimming

window.  The example shown in 
fig.12.1.3.5.2 gives an idea of the 
flexibility of the formatting.

12.1.3.6 Formatting text

Textural data can be Trimmed 
(fig.12.1.3.6.1) Justified 
(fig.12.1.3.6.2) or have data re-

Fig.12.1.3.6.2 Text format - Justify

Allows the user to extract sections 
of the data entered where required.  
This can be starting from the:

Data can be padded to a specific 
Fig.12.1.3.6.3 Text format - Replace
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If it text should be standardised, for 
example plc should always be dis-
played as lower case, all permuta-
tions can be set up to be replaced 
with the correct structure.

<Add> as many replacedments as 
are necessary to ensuring con-
sistency of output.  Any incorrect 
replacements may be selected and 
<Removed>.

12.1.3.7 Formatting Numbers

Numbers can be formatted to be 
fixed width (leading zeroes) and 
with a set number of digits before 
and after decimal places (see fig. 
12.1.3.7.1)

12.1.3.8 Formatting Currency

Currency can be formatted in the 
same way as numbers (see section 
12.1.3.7 Formatting numbers).  

In addition to the number settings 
it is possible to export the currency 
acronym (see fig. 12.1.3.8.1).  If 
exported; it can be placed before or 
after the data.

If it text should be standardised, for 
example plc should always be dis-
played as lower case, all permuta-
tions can be set up to be replaced 
with the correct structure.

<Add> as many replacedments as 
are necessary to ensuring con-
sistency of output.  Any incorrect 
replacements may be selected and 
<Removed>.

12.1.3.7 Formatting NumbersFig.12.1.3.7.1 Number format

Numbers can be formatted to be 
fixed width (leading zeroes) and 
with a set number of digits before 
and after decimal places (see fig. 
12.1.3.7.1)

12.1.3.8 Formatting Currency

Currency can be formatted in the 
same way as numbers (see section 
12.1.3.7 Formatting numbers).  

In addition to the number settings 
it is possible to export the currency 
acronym (see fig. 12.1.3.8.1).  If Fig.12.1.3.8.1 Currency format
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